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Choropleth Mapping

A word to the wise: Allow plenty of time for this project.

Learning goals:  

1. What spatial patterns of ‘Literacy’ can you detect between countries in Africa?
2. What are the fundamentals of choropleth map design?
3.  What difference do data classification methods make with regard to data representation?
Files you need:

· Africa shapefile and HDI2000.dbf

Turn in:

1. Two maps with two different data classification methods

2. Data table with class breaks indicated 
3. Graph (from Excel) with class breaks indicated

4. Responses to the questions posed at the end of this project

Tasks & Steps
 
In this part of the project you will produce two choropleth maps of the same attribute using two different data classification methods.  You are limited to choosing two classification methods out of the four discussed and reviewed (Jenks natural breaks, equal intervals, quantiles, and manual).  The steps described below show you how to acquire data files to build your own map document. In this part of the project we will work with country level data for the entire world (with some exceptions); the same steps can be followed to create a map document for any area.  Before you start this project review the four data classification methods covered in class: Jenks natural breaks, equal interval, quantiles, and manual. Ask your TA for clarification if they are not clear. You are welcome to work with a partner on this project, though it is important to make sure that both of you are comfortable manipulating the software! You will need to work with a partner to answer the questions at the end of the project. Note: Each pair needs to submit only one copy of the answers to the questions, ensuring that both names appear on the answers! If you work independently on making your maps, just submit each partner’s maps, data table, and graph with your answers to the questions.
Make two choropleth maps:

Acquire the spatial boundary data for countries in Africa.

1. The data for this lab assignment (as for the rest of them) are in the P:\ drive, under the class folder (P:\geog360s09\). Copy the folder named project3 (P:\geog360s08\project3\) into your own S:\ drive. If you do not recall how to copy folders, please revisit lab assignments 1 and 2 or follow the simplified instructions below:

a. Open “My Computer” from the Desktop or through the Start menu

b. Click on the P:\ drive

c. Navigate to the geog360s09 folder

d. Right-click on the project3 folder and select Copy
e. Navigate to your own drive (S:\), right click and select Paste
2. Login and start ArcGIS, ArcMap, choosing the option to open “a new empty map” as you did in the previous project.  Click the File drop-down menu and choose “Add Data”, or click on the Add data symbol: [image: image1.png]


.

3. You’ll need to map the data directory (on the P:\ drive) to your project so click on the symbol with the globe and arrow which says “Connect to Folder” when you put your cursor over it: [image: image2.png]


. Locate and select the project3 folder using the same set of steps you followed in last week’s project. This will map the data folder to your project, allowing you to manage the data easily.

4. Open the data folder by double-clicking on it.

5. Click once on the Africa.shp file to highlight it, click the ‘Add’ button in the lower right corner of the dialogue box.  You have added a shapefile to your data frame. 

Remember to save your work periodically, using ‘File(Save As’ procedure you used in the previous project. Review those instructions if you forgot how to do this. Remember that you want to navigate to your own personal folder on the S:\. This project will generate several new files, and you can save yourself a lot of hassle by making sure that they are in a folder separated from all your other work.
Understand your layer

1. Open the attribute table to examine the data associated with the Africa shapefile. If you need detailed instructions on how to do this, review those given in a previous project (start by right clicking on the Africa layer…)

2. Once you have opened the attribute table associated with the Africa shapefile, take a look at the contents, noticing the fields (columns) and the records (rows)

3. You will notice that this attribute table does not contain any information regarding literacy you will need to add that data to your map document and then join that data to the Africa shapefile.

Add a data table to your map document

1.  Close the attribute table.

2. Click on the ‘add data’ button: [image: image3.png]



3. You should be looking in the S:\project3\data folder in this dialog box.

4. Find the HDI2000.dbf file and double-click on it.

5. The dialogue box should disappear and you will see the HDI2000 file in your table of contents.  The next step will be to join this table to the Africa boundary file. That is, the Africa shapefile contains your “spatial data” and .dbf file contains your “attribute data”. We need to join them so that you will be able to map the data contained in the .dbf table. Note: Knowing how to join spatial and attribute data is an essential skill for successful GIS use. Make sure you understand this process completely, because you will carry it out again and again in future GIS use.
Join spatial data to attribute data
1. In order to join two different data tables (one with spatial data and the other with attribute data), you must make sure that your two tables have the same unique identifier.  A unique identifier is a field that contains a unique value for each record.   ArcMap needs to know on which field to base the join, the field that contains the same unique identifier for both data tables will serve as the basis for the join.

2. Inspect the HDI2000 data table by opening it.  To open the table, right click on HDI2000, choose open.  Scroll around to look at the various fields and records.  

3. Which field seems to have a unique data value for each record? ___________________.

4. Which field also appears in the Africa data file? _____________________. Note: the two fields do not need to have identical “fieldnames” at the top of the Attribute Table, but the data contained within the cells of the field in both tables must match.

5. In the table of contents, click on Africa to highlight it.  Right click on it to make the drop-down menu appear.  

6. Choose joins and relates, then choose join.

7. A Join Data dialogue box will appear.

8. The first question you need to answer is “What do you want to join to this layer?”  Note that you will join something to the layer that you have highlighted.  Keep the default instruction: “Join attributes from a table”.

9. Next you are asked to “Choose the field in this layer that the join will be based on:” If you click on the drop-down button you will be able to select among several different fields.  Choose the one that contains the unique identifier, as identified in steps 3 and 4.

10. Next you are asked to “Choose the table to join to this layer, or load the table from disk:” Be sure that HDI2000 is indicated in the box.

11. The third step is to “Choose the field in the table to base the join on”. Once again, this is the unique identifier that you identified in steps 3 and 4.  Don’t worry if the field names are not the same for both tables, it is the data content that matters. 

12. Once this is set up, click ‘OK’. The computer may ask if you want to index the table. For our purposes, it does not matter either way. I usually select the default option that is suggested in this dialogue box.

13. Now you should inspect your table to make sure that your join was successful.  Open the table for Africa.  You should see that all of the information from HDI2000 has been appended to the table for Africa.  If you see empty cells in the table, or all the cells are filled with <null>, this is a good clue that something went wrong with your join. A few <null> cells is okay, as you will find out in the next section of this project.

14. This is a good time to save your project.  Important:  ArcGIS has not created a new table based on the join, all that will be saved are the instructions (or pointers) that you just gave.  Therefore, if you wish to work on this project at another computer (where you don’t have the network connection), be sure to take a copy of the HDI2000 table.

15. Look at the data.  Click on the fieldname that contains the country names and highlight it.  Right click and choose ‘freeze/unfreeze column’.  This will keep that column in your view while you scroll left and right to inspect the other columns.  Close the table.

Select an attribute to map

1. Right click on Africa in the table of contents. Go to the bottom of the drop-down menu and choose ‘Properties’.

2. Click on the tab at the top of the dialogue box labeled ‘Symbology’.

3. Where it says ‘Show’, to the left of the dialogue box, Features should be highlighted, that is the default.  You will be mapping quantities (in terms of literacy) so choose ‘quantities’.

4. When you click on ‘quantities’, four choices appear: graduated colors, graduated symbols, proportional symbols, and dot density.  Click on each one so that you can see what they do.  In order to make a choropleth map, select ‘graduated colors’.

5. In the ‘value’ drop-down box: [image: image4.png]Fields-
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, choose ‘ADULT_LITE.  You have just selected the attribute that will appear on your choropleth map.  Leave the ‘normalization’ box empty (<NONE>).

The Human Development Indicators presented in the HDI2000.dbf table were compiled and published by the United Nations Development Programme (UNDP).  The Human Development Index (HDI) is a combination of three indicators: longevity (measured by life expectancy), education (measured by adult (15 years and older) literacy and primary, secondary, and tertiary school enrolment), and standard of living (measured in terms of Gross Domestic Product (GDP) per capita (which takes the total value of goods and services produced in a country and divides it by the total number of people in that country)). Rates, such as literacy or life expectancy, are converted into an index.  The Human Development Index is the average of the three indexes (.00 to 1.00).  You can think about the HDI as a measure of a nation’s well-being based on the three indicators mentioned above. More information about this index is at: www.undp.org/hdro/.  

6. Look at the color ramp selections.  Since we are limited to printing in black and white, choose the color ramp that ranges from black to white.

7. Normally the color should ramp from light to dark with the darkest color value representing the higher data values. Look at the symbol column. If black is associated with the smallest values, click on the word ‘Symbol’.  Choose ‘Flip Symbols’ to reverse the color ramp.  Decide if your map works better with high literacy shown as dark or light.

Classify your attribute
1. In the dialogue box you should now see 5 data classes that are represented by graduated colors.  ArcMap uses the Jenks iterative method (ESRI calls it natural breaks, but it is not the same) (with 5 classes) as a default classification.  Click on the ‘classify’ button [image: image5.png]Classification
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 to change the classification method.  
2. A dialogue box will appear that presents you with a histogram showing how the data are broken into various classes, depending on the method you select.  Experiment with the various methods (manual, equal interval, defined interval, quantile, Jenks, standard deviation) to see how the class breaks change.  To set class breaks manually, simply grab the blue class break line and move it along the histogram; this is how you implement true natural breaks in this software. Spend some time changing the number of class breaks and studying the differences before moving on.  Ask yourself how many classes make sense visually. How many classes do you need to visually / cartographically tell the story you are telling? Once you have selected the classification method you want, click ‘apply’ and ‘OK’.  
Now look carefully at the display.

a) Notice some countries don’t appear in the display. Use the identify tool [image: image6.jpg]


 and click on one of the countries that does not appear. The HDI2000.Adult_LITE attribute is <null>. This means there is no data for that particular country.  Visually this is problematic. It would be poor cartographic practice to leave these countries blank.  Next you will Create a new layer from the Africa.shp and name it “no data” 

b) Use the add [image: image7.png]


 button and add Africa.shp again so that appears twice in the Table of Contents.  Right click on the newly added word Africa in the TOC.  Select properties and choose the general tab. Now change the layer name to “no data” You will use the no data layer as a backdrop for the Africa layer. 

c) In the layer properties dialog box choose symbology.  Click on the colored symbol box.  Now scroll through the symbol selections and choose a symbol or color that you feel best represents countries with no data.  Remember, we don’t want countries with no data to dominate the map so choose something that visually places them in the background and not the foreground.  Consider the visual hierarchy. (What you want the reader to see) and intellectual hierarchy (the message you wish to impart to the reader)

d) Layers in the Table of Contents are ordered from top to bottom.  Click on the No Data layer and drag it below the Africa layer.  

Create a Map Layout and Print your map

1. Once you are satisfied with the way the data are represented, you are ready to create an attractive visual presentation.  Go to the View drop-down menu and select Layout view or simply click on the small layout icon at the bottom of the screen: [image: image8.png]


.

2. Refer to the instructions for creating a map layout in Project 2.

3. To change the title of the attribute to something that will make sense to the map-reader, click once on the title that appears above the classification in the table of contents (Hint: be sure the tip of the cursor arrow is over one of the letters).  Click it again once and it will let you type over what is currently there. This will be updated automatically in the legend in your layout. Change the name of the layer to indicate the classification method you used.  

4. In your layout, edit the legend title. The legend should tell the map-reader what attribute or indicator is being mapped and how it is being measured in as simple and explicit language as possible.  

5. Think carefully about your map title, be sure to consider the three geographic information aspects: time, space, attribute.  Your map title should be different from your legend title (if you feel you need a legend title) and should present your reader with the ‘big picture’.  What are you trying to convey with your map?  What is the one main message you want your reader to understand or consider?  You can incorporate your legend title into your map title, but in simpler language.

6. Use the text tool to add additional information to your map.  Be sure to include:

· Your name

· The date

· Data source

· The classification method you used for each map.

7. When designing your layout, think through visual hierarchy and intellectual hierarchy – what is most important, second most important…least important.  How can you make the more important parts stand out?  How can you make your map as clear and concise as possible?

8. When you are satisfied with your map, go to the File drop-down menu and choose ‘Print’.  A printer dialogue box will appear, if everything looks accurate, click ‘OK’.

A note about exporting maps:  If you want to use your maps in Word, PowerPoint or on the web etc., you will need to export them as image files.  To export a map, use the drop down menu at the top of your display to choose File(Export Map. Select a file type. (.jpg  .tiff  are probably the most versatile). Name your maps and save them to your folder on P:  We strongly recommend you save all of your maps this way so that you can easily save them to disk or Dante at the end of the quarter. Save your project again! Remember this is File(Save As.
The next step will be to make a second choropleth map with the same attribute, but a different classification method.  First, save a copy of your current project with a new name (Project 3_2.mxd or Project 3b.mxd or something like that). Notice the name change on the blue bar in upper left hand corner. Keep notes for yourself in order to be able to identify at a later stage which classification method you used in each project! Since you will be mapping the same attribute, and altering only the classification method, you can use Project3_2 as a template for your next map. 

Now you need to go into the layer Africa properties dialog box and change the classification method, be sure to keep the same number of classes.  Follow the steps you used before to classify your data, but use a different method to re-classify your data.  

1. In the layout view make the necessary changes (signify which classification you used)

2. Save your work.

3. Print out your map with the second classification.

4. You may want to repeat the steps above to create a third map with another classification method, so you can compare the results.

Manually demonstrate the classification methods you used for your choropleth maps:

 
In this step, you will explore your data in table format, using Excel. The first step is to export your attribute data for use with Excel. 
1. In the beginning of this project you joined the HDI to the Africa layer and created two map documents: Project3.mxd and Project3_2.mxd.  Next you will manually demonstrate the classification schemes you employed to make your maps.

2. The best way to examine the data is to export the table as a .dbf  (Database IV file) and open it in Excel. In the table of contents highlight the Africa layer (it doesn’t matter which document you use. The data is the same for both) containing the data you wish to view.  Right click and open the attribute table.

3. Find the ‘options’ button at the bottom of the table: [image: image9.png]Options ~



, click on it and select ‘export…’.

4. A new dialogue box will appear.  Keep the default set to ‘export all records’.  Check the path for the Output table.  Important: Make sure that it is going to your folder! Otherwise you may have trouble figuring out where the file saved. Give it a name that makes sense to you (e.g. literacy.dbf).  The extension must be .dbf – it is a dBase file.  Click ‘OK’. A small window will appear asking if you want to add the data to the current map. Say No.

5. Now you can open your table in Excel (you can keep ArcMAP open and running).  Go to the Start button, choose Programs, choose Microsoft Excel.  The Excel program appears.  Notice the buttons at the bottom of your screen.  You can go back to ArcMap simply by clicking on the ArcMap button at the bottom of the screen.

6. In Excel, go the File drop-down menu, choose Open.

7. At the bottom of the dialogue box change Files of type to All Files (*.*).
8. Navigate to your folder and the .dbf you have just created.  Double-click on it.  Your table should open in Excel.  

9. You are going to sort this table by the ADULT_LITE, the attribute that you just mapped.  Before you do this, delete the columns that are not pertinent – all except for country name ‘NAME’ and the Adult literacy ‘ADULT_LITE’.  To delete a column in Excel, highlight the column by clicking on the letter above the column, go to the Edit drop-down menu and choose Delete.  You can select several columns at once by using the shift key as you highlight them.

10. Now your table is simplified, you have a field for the country name and a field for ADULT_LITE.  Sort based on the ADULT_LITE.  Click on the cell (ADULT_LITE) (not the whole column! )  Sort by ascending order by clicking on the ‘sort by ascending order’ button: [image: image10.png]


.  

11. Inspect your table by scrolling through it.  What does it mean when a country has an ADULT_LITE of 0.000?  Why do you think that is?  What countries have the lowest values, which ones have the highest values?  

12. Print your Excel table.  Try to fit all of the data onto three pages.  Go to the File drop-down menu, choose Print Preview.  

13. Click on the Setup button: [image: image11.png]


.  

14. In the Page Setup dialogue box, set the scaling to a % value that will [image: image12.png]Scaling
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 allow you to print the entire table on one page.  Click ‘OK’, hit the Print button.  

Examine your data table.  Mark on your table where the class breaks are for 5 classes of data for the 1) quantiles method, 2) equal interval method, 3) natural breaks (Jenks) method.  Be sure to distinguish each method from the others in some way (e.g. colored pens, dotted or dashed lines).  Hint:  Refer to the legends on your maps to determine the class breaks or calculate the class limits manually. 
Now you’ll examine your data as a graphic array:

1. In your Excel spreadsheet, click on the graph icon at the top of the screen: [image: image13.png]


.

2. When Excel asks you to choose your chart type, select the default: [image: image14.png]


.

3. Click the next button. 

4. Excel now wants to know which columns to include in the chart.  Select the column with the country name and the one with ADULT_LITE.  Since these should be the only two columns that you can see, the default setting should be correct, click next.

5. In the Chart Wizard dialogue box, change the title of the chart to something that is readable (e.g.: Human Development Index 2000).

6. In this dialogue box, you can also enter titles for the x axis and the y axis. 

7. In this dialogue box, click on the legend tool and un-check the box that says ‘show legend’.  In this case, if you give your chart an appropriate title, you don’t need a legend.  Click next.

8. Excel now asks where you want to put this chart.  Click the ‘as a new sheet’ radio button: [image: image15.png]& s new sheet:




.  Click finish.  Your chart will appear on a new page, in the same Excel file as your table.

9. If you do not want the country names to appear on the x axis, right click on the axis and choose clear.

10. Note that if you put your cursor on one of the lines in the chart a small dialogue box will appear with the country’s name and ADULT_LITE value.

11. When you are satisfied with your chart, print it by clicking on the print button at the top of the screen: [image: image16.png]


.

12. Mark on your graphic array where the class breaks are, like you did with your data table.  Use different colors or different symbolization to indicate the different classification methods.  (You will have to use your best judgment in placing your class breaks.)

 
Interpret Information From Your Data Analysis

Now that you have made your two maps, you are ready to interpret the information from your data analysis.  Consider what you have learned from lecture, by reading the text readings and by completing this project to answer the following questions on a separate (typed) sheet of paper. You may either retype the questions below, and type in your answers, or you can download the Project Three Answer Sheet from the course website. Work with a partner to answer these questions. Number your responses to correspond with these questions, and make sure both partner’s names are on your answer sheet!

Questions 

1. You used three different ways of structuring the information to look at literacy by country: a table, a graphic array, and a map, call them three different information structures (presentation techniques) since the data are the same.  What information comes through for each representation? What are the advantages and disadvantages of each structure?

2. How do we use choropleth map design to convey information about literacy patterns?

3. Describe each of the three classification methods that you have used in your own words. 

4. What difference does data classification method make?  Be as specific as possible (with regard to geography) when discussing the differences.  How did the different classification methods convey different messages about literacy?

5. Which data classification method do you think worked best for the topic?  Why?

6. Suppose that you work for the United Nations.  You are trying to make a decision about which nations to support with your limited economic resources, how might your decisions differ based on the various classification methods? What recommendations do you have for those making cartographic design choices when dealing with human development policy considerations?
The following questions are for GEOG560 students only:

7. Do the data category and the data measurement used in this lab assignment address the lab assignment objective? Why or why not?
8. How do the three realms of geographic information representation (worldview, database, and display) interact in this lab assignment?

9. If you had the opportunity to revise this assignment, what would you introduce, remove, or emphasize further?
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